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MS Excel 
 
Opening a Report 

 
There are three types of reports: Single reports, reports by district, and reports by 
county.  Find the report you would like to view and right click on it.  This will bring 
up a sub-menu.  Select the option to Save Target As. 
 

 
 

Select where on your drive you would like to save the report and click Save.  
Open the report by double clicking the report that you just saved on your hard 
drive. 
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Manipulating the Report Layout 
 
Expanding the columns 
 
When you initially open the file you will notice that all of the columns are 
compressed in size and cut off much of the information you need.  Click on the 
gray box in the upper left hand corner of the Excel spreadsheet to highlight the 
entire spreadsheet. 
 
 
 
 
 
 

 
 
Then place your cursor in-between the first and second columns until your cursor 
becomes a vertical line with an arrow on either side.  Double click and all 
columns will expand to the length of the longest piece of information in that 
column. 

1. Highlight the 
spreadsheet by 
clicking here. 

2.  Place cursor between 
columns and double click 
to expand columns. 
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Freezing Panes 
 
Usually you want to keep the column names at the top of the spreadsheet as you 
are scrolling down so you do not have to scroll up to remember what column you 
are looking at.  You want to “freeze panes”.  This can be done to keep any 
amount of columns on the left of the screen or any amount of rows on the top of 
the screen from moving while you are scrolling.   
 
1. Highlight the cell that is immediately below the rows you want to keep on the 

top of the screen and immediately to the right of the columns you want to 
keep on the left of the screen.   

 
In the example below we want to keep the left two columns on the screen as well 
as the very top row.  Therefore we will place our cursor in cell C2.    
 
2. Open the Window menu on the menu bar and select Freeze Panes.   
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3. The County and Facility ID columns, as well as the row of column names, on 
the left and top of the screen respectively will be displayed at all times. 

1.  Select cell 
C2. 

2.  Select Freeze Panes from 
the Window menu 
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Printing Reports 
 
Printing the Same Column or Rows on Multiple Sheets 
 
If you are printing a report and you want a specific row (column names) or a 
specific column, such as Facility ID, to print out on each page select Page Setup 
from the File menu.   
 
1. Click on the sheet tab at the top. 
 

 
 

1. Click 
the sheet 
tab. 
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2. Click on the box icon that is in the field that pertains to what you would like to 
do (repeat a row or a column).   

 
 
 
 
 
 

 
 
3. This will take you back to the report.  Just highlight the letters or numbers 

corresponding to which rows/columns you would like to repeat.  For this 
demonstration we are using rows 1 through 3.  Note that the rows you select 
will be displayed in the Rows to repeat on top dialog box. 

 
 
 
 
 
 
 
 
 
 
 
 

2. Click the box icon 
that pertains to what 
you want to do. 
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4. Select the box at the end of the field in the “Row to repeat at top” dialog box 

to finalize your row selection and return to the page setup dialog box. 
 
5. Repeat these steps to repeat a column. 

 

3. Select the rows you 
want to repeat by 
selecting the appropriate 
row numbers. 

Note: The rows you 
selected will be 
displayed in this 
dialog box. 

4. Click here 
to finalize 
your 
selection. 
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Printing Your Report 
 
Most of the Public Internet Reports contain too much information to print.  Please 
refer to the section on how to manipulate the reports in order to make sure you 
are printing just the information you need. 
 
1. Open the report you want to print. 
 
2. Make sure you have formatted the report and are only printing the information 

you need.  Please see the sections on manipulating the report layout and 
hiding & deleting columns to help you with this. 

 
3. Open the print dialog box by clicking on the File menu, Print. 
 

 
 
4. This will open the print dialog box.   
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5. Please check the following things: 
 

a) Number of pages that are going to print.  Unless you specify otherwise in 
the print dialog box, all of the pages of the report are going to print.   

 

 
 
 
 
 
 
 
 
 
 
 

NOTE:  To see how many pages will print, use the print preview button 
on the menu bar of the report , and then check the number of pages 
that will print in the bottom left corner of the report. 



Florida Department of Environmental Protection 

 11 How to Use DEP Internet Reports 
07/2004 

V. 2.1 
 

 

 
 
 
 
 
 
Page Orientation  
 
If you are printing a report that has many columns it might be beneficial to print 
your report in landscape orientation so you can fit more columns on each page.  
If you are printing a report with many rows and only a few columns it would be 
beneficial to print in portrait orientation.  Every printer is set up differently, please 
consult your user manual on how to change the page orientation.

Number of pages 
that will print. 
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Finding Information for a Specific Facility ID Number 

 
1. Highlight the Facility ID column by clicking on the letter for that column.  
 

 
 
2. Press Ctrl + F.  This opens the find dialog box.  Enter the Facility ID that you 

would like to search for.  For this example, let’s use 9200178. 
 
 
 
 
 
 
 

 
 
3. Click on Find Next to find information for that Facility ID.   

2. Enter the 
Facility ID you 
want to search 
for. 

3. Click Find Next to 
find the first 
occurrence of your 
search criteria. 



Florida Department of Environmental Protection 

 13 How to Use DEP Internet Reports 
07/2004 

V. 2.1 
 

 

4. When it finds the Facility ID you entered it will be highlighted in white. 
 

 
 
5. Continuing to click the Find Next button will find other occurrences of the 

Facility ID you’re searching for. 
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Sorting 
 
Sorting can make it easier to find the information you are searching for by listing 
the information in a certain order.   
 
1. If the report is not sorted how you would like it to be, just highlight the column 

you want to sort by, click on Data in the menu and click Sort. 
 

 
 
2. A menu will pop up saying that Excel found data next to the column of data 

that you would like to sort.   
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3. Indicate that you want to expand your selection and click the Sort button.  If 
you do not expand the selection, the highlighted column will be sorted 
and the other columns will not be sorted. This will give you incorrect 
results. Choosing to expand the selection will keep all the rows together 
when the data is re-sorted. 

 
4. A criteria box will then appear and ask you how you would like to sort your 

data.  Indicate how you would like to sort your information, make sure the 
option is checked that indicates you have a header row (column names), and 
then click OK.  For this example we are going to sort by Facility ID first and 
then by county. 

 

 
 

5. Your list is now sorted. 
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Filtering 
 
Filtering allows you to narrow a broad range of data in a spreadsheet and 
manipulate it to become a list of data that is useful for you.  For this example we 
only want to look at facilities that are closed.  However, our spreadsheet shows 
all facilities in Leon county.  We can use a filter to narrow this list to show only 
facilities in Leon county that are closed. 
 
1. Highlight a cell that is in the column that you want to filter by. 
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2.  Click on the Data menu and select Filter, Auto Filter 
 

 
 
Drop down boxes appear at the top of every column.  Click the drop down box to 
choose what you would like to filter on.  There are 2 ways to filter: A “literal” filter 
and a comparison filter. 
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a) Literal filters are used to display rows that have a specific value.  Click on 
the drop down box on the top of a column.  Pick what “literal” piece of 
information to search for. 

 

 
 

Literal Filter 
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b) Comparison filters allow you to search using search “criteria”.  If you are 
going to filter to find more than one set of criteria (i.e. list facilities that are 
anything but open) you will need to use a comparison filter. 

 
i) Select custom from the drop menu at the top of the column you are 

using to filter.  This will open a custom filter dialog box. 
 

 
 

For this example we wanted all facilities that have a status of anything other than 
open.  Therefore we chose Facility Status does not equal open for our criteria. 
This filter will return all rows where Facility Status is anything other than open. 

 
ii) To use 2 sets of filter criteria, enter the first set of information that you 

want to be your primary filter and then enter your second set of 
information to be your secondary filter. 

 
iii) Select which set of criteria you want to use.  If you select AND then 

both sets of criteria have to be equal in order for the filter to work 
properly.  If you select OR than only one set of criteria has to be true 
for the filter to work properly.  In this example we want to return 
stations with the name Chevron or Shell, so we will use the OR option 
since a station only has one name and we want stations with the name 
Chevron OR Shell. 

 
 
 
 

Note that you may choose to have 2 sets of filter criteria when using 
the custom filter. 

The list will be sorted using your primary filter first and then again 
using your secondary filter. 
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iv) Select OK to filter the spreadsheet 

ii.  Enter both sets of 
criteria you want to filter 
on. 

iii.  Select whether you want both 
sets of criteria to be true, or where 
only one has to be true. 

iv.  Click OK to filter 
the spreadsheet. 
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Hiding and Deleting Columns 
 
Many of our reports have so many columns of information that they can not all fit 
on one page when printed.  Therefore you may wish to delete or hide the 
columns you do not want to see when printing and/or looking at the report on 
your screen. 
 
Deleting A Column 
 
1. Highlight the column you want to delete by clicking on the letter for that 

column at the top of the screen. 
 
2. Right click anywhere in the column and select delete. 
 

 
 
 

 
 

NOTE:  Deleting a column is permanent!  If you think you may want the 
column in the report sometime in the future you should use the “hide” 
function. 
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Hiding A Column 
 
Hiding a column gives you the same luxury as deleting it but allows you to unhide 
it should you want to view it again later. 
 
1. Highlight the column you want to hide by clicking on its respective letter at the 

top of the column. 
 
2. Right click anywhere on the column and select hide. 
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Unhiding a Column 
 
1. Place your cursor in the gray bar at the top of the screen just to the right of 

where the letter representations of your hidden column is (i.e.  if you hide 
column I and column H and J are displayed, place your cursor in the row of 
letters representing the columns on the line in between columns H and J). 

 
2. The cursor will turn to two solid vertical lines.  Right click and select Unhide to 

expose the hidden column. 
 
 
 
 
 
 

 
 

When your cursor turns to double vertical lines, 
right click and select Unhide from the pop up 
menu. 
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Using MS Access to Link Two or More Reports Together 
 
There may be times when you would like the data from 2 or more reports to be 
shown in one single report.  We can do this using Microsoft Access.  Microsoft 
Access is a database application but it does allow you to import MS Excel 
worksheets as tables.  In this section we will through importing 2 Excel 
worksheets into Access, linking them, and creating a single report containing 
information from both tables. 
 
Create a Blank Database 
 
Open MS Access and select the choice for creating a blank database.  It will then 
ask you to name the database and select where you plan on saving it. 
 



Florida Department of Environmental Protection 

 25 How to Use DEP Internet Reports 
07/2004 

V. 2.1 
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Importing Tables (Data) 
 
Select the reports you want data from and save them to your computer.  In this 
example we want all the insurance information for site in Alachua county, but we 
also want to include the owner contact information for these sites.  Therefore we 
need both the All Locations and Insurance Information report for Alachua county 
as well as the All Locations and Owner Information report for Alachua county.  
Once you save these reports to your computer they can be imported into Access. 
 
While you are on the tables tab click the New button.  Select Import Table and 
click OK.  Navigate to the location you saved the reports.  Change the data type 
at the bottom of the dialog box to MS Excel.  Highlight the first report you want to 
enter and select OK. 
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Now we need to set up the import options.  The first thing we need to do is tell it 
what worksheet we are trying to import.  There should be only one with the 
database reports you downloaded.  Click the next button.   
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On the following screen you need to make sure that you check the box that lets 
Access know that the first row contains the column headings and then click the 
next button. 
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The following screen asks you what you would like to name the table you are 
importing.  You can leave the default settings by pressing the next button. 
 



Florida Department of Environmental Protection 

 30 How to Use DEP Internet Reports 
07/2004 

V. 2.1 
 

 

 
 
 

On the next screen you are asked to establish a primary key for the table you are 
importing.  Primary keys are a unique identifier in the table.  They are never 
blank (null) and they never repeat themselves.  Select the setting that says no 
primary key so we do not risk deleting records, and click next. 
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The next table asks you to name your table.  You can rename it if you would like 
to, but I am going to leave mine with the original table name.  Click finish and we 
are done!  Repeat this process for each table you want to import. 
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Creating Your Own Reports 
 
Now that we have the tables we want in our database we are ready to create our 
custom report.  We will do this by creating a query.  Click on the query object 
button on the left side of the database main screen. 
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The following screen will ask you how you want to create your query.  Select 
design view and click next.  
 

 
 

Now we need to tell Access which tables we are going to need data from for this 
report.  Highlight the table you want to include and click add.  Repeat this 
procedure for every table you want to include in this report.  When you are done 
adding tables just clock the close button. 
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NOTE:  You can use more than just tables to create queries.  You can also use 
queries as well.  This is useful when dealing with difficult join situations. 
 

 
 

Now you have everything you need to create your report, but we have not 
selected how to join the 2 tables together.  We can not include data from both 
tables unless there is a relationship amongst the two.  Select a common field that 
is in both tables.  You must be extremely careful when doing this.  You want to 
pick a field that has a uniqueness to it in both tables.  99.9% of the time this will 
either be the discharge_id field or the facility_id field.  We want to look at data on 
a facility level so we will choose facility_id.  Left click on the facility_id in one 
table and hold that click down while you drag your mouse to the facility_id field in 
the other table and let go.  You will now see a line between the 2 tables.  Right 
now if you left it like this the only data that would show up would be the rows of 
data that exist in both tables.  If either table had a null in the field that you used to 
join on (facility_id) then it would not be included.  There may be sometimes when 
you want to return every single row in a table whether it has a null in a certain 
field or not.  This is accomplished using inner and outer joins.  Access has made 
this simple for you.  Right click on the line between the 2 fields and a sub menu 
will appear.  Select join properties. 
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Now we can tell Access what type of join we want based on the description.  In 
this case we want all owner records and all the records in insurance where there 
is a matching facility_id.  So we would select option 3. 
 
Now all you have to do is double click on each field in the tables that you want in 
your report and they will be added at the bottom of your screen. 
 

 
 

Adding Parameters (Requirements) to Your Reports 
 
Ever want to have a report that is specific to just your county or district?  How 
about have a report just for Exxon stations?  This section will tell you how to do 
that using query parameters.  This is very similar to using filters in Exel.  If you do 
not want to use parameters then you can skip to the next section of this 
document on creating the finished product. 
 
We are still working with the query we just built.  We want to search for facilities 
that are in Tallahassee or in a specific zip code, or within a range of zip codes.  
Notice the following screen.  Look at the criteria line.  Each line represents one 
“condition”.  For instance, the facilities this report will return will have Tallahassee 
(exactly as it is spelled in the criteria) for the city AND have a zip code of 32301. 
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If we look just at just the first row under criteria it would return every row where 
fac_city is tallahassee AND the fac_zip is 32301.  But notice we have a second 
row.  This is known as the “or” row.  The entire statement reads: return every row 
where (fac_city is tallahassee AND fac_zip is 32301) OR (fac_city has any word 
with tall in it AND fac_zip is either 32301, 32302 or 32303).  Note that strings of 
text must be enclosed in single quotation marks when you are using them in a list 
like we did with the multiple zip codes.  If the list parameter is a number you do 
not have to use quotes.  Each line is a statement in itself.  Each parameter per 
line must exist for a row to be returned.  If you use the “or” line and some of the 
parameters are the same ones you used in the line above it, they still must be 
repeated in the 2nd or 3rd lines if you want the same to be true for each statement.  
This issue can get real confusing.  I suggest reading the MS Access help files for 
more information. 

 
Getting a Finished Report 
 
We have selected each column of information we want in the report.  Please 
make sure the “show” check box is checked so that the column will be in the 
report.  Lastly we have to tell Access what to do with the data once the report is 
run.  The 2 main choices we normally use are a “select” query and a “make table” 
query.  The select query will return the same data that make table query will 
return except you can not manipulate the data in any way, it is read only.  A 
make table query will create an access table for you that has all of the data in it 
that the report returns.  Select this option if you want to save the data from the 
report or export it into MS Excel format.  At the top of the query screen in the tool 
bar there is a button with 2 tables on it, one in front of the other and a little offset 
with an arrow next to it.  Click on this button.  Now you have the option to tell 
Access what to do with the report data when you create the report.  For this 
example we are going to use a make table query. 
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After selecting the make table query option you will be asked to provide a name 
for the table Access will create.  Give it a name and press the OK button.  Now 
all we have to is run the report.  Press the button with the explanation mark [ ! ] 
on the tool bar that is next to the button you pressed to select which kind of query 
you wanted.  You will get a message when your report has been created. 
 
Exporting Your Report into MS Excel 
 
If you plan on sharing this report with anyone you will need to export your data 
into a format that they can read in case they do not have MS Access.  A program 
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commonly used for reports in DEP is MS Excel.  To export a table into MS Excel 
format click on the tables button on main database screen.  Right click on the 
table you would like to export and select the export option.  A dialog box will 
appear and you just need to tell it where to save the file and what file type you 
would like to export to and then click save.  NOTE:  MS Excel has a row limit of 
65,000 rows! 
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